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Format as Table Features by Neale Blackwood A4 Accounting

Introduction

Excel is a spreadsheet not a data base, but it does haves many useful data handling features. Excel
works well with tables and lists. You can add structure to your spreadsheet files by using tables and
lists for your options.

This feature, which has an icon on the Home Ribbon tab, has greatly improved how Excel deals with
tables.

Sheets have over one million rows and over 16,000 columns, so Excel can handle large amounts of
data.

This session will cover the Format as Table feature in depth as well as some features that work
better with it or require it.

Terminology
In data base terms a row is a Record and a column is a Field. Column headings are Field headings.
Data Table rules

Don’t have blanks rows within your data (if you need a visual break between types of data in a data
table change the row height rather than inserting a blank row). Blanks rows can also affect the
usefulness of some shortcuts.

Don’t have blank columns within your data (a column heading with no data underneath is ok).

Ill

If you have blank rows or columns it affects how well Excel “guesses” the data table range.
Right Clicking

Right click options associated with Data. A Filter and Sort option is available.

Colours ‘o
& cut [ copy

The right click [ copy o poveoptons

options now also Paste Options: £y

Paste Special...

include the ability
to filter and sort by

/‘::‘ Smart Lookup

S Smart Leckup

Insert >
colour.
Insert > Delete >
. Select >
This can work hand Delese >
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In na wi i s )
a t Clear Coptents &l Quick Analysis
conditional & uick Anaysi st ’
H 5| a Filter >
formatting to e Ly 2l mrawz Iy
id Filter > Z] sonzton Table >
pl"OVI € some Table > Put Selected Cell Coler On Top 3 New Comment Filter by Selected Cell's Value
advanced fllterlng %] New Comment Put Selected Font Calor On Top {3 NewNote Filter by Selected Cell's Color
H : 13 MewNote Put Selected Formatting lcon On Top [F] Eormat Cells.. Filter by Selected Cell's Font Color
and sorting options. = _ B
[E] Eormat Celis.. Custom Sort... Pick From Drop-down List... Filter by Selected Cell's lcon
Pick From Drop-cown List... @ Link > heet? | SalesData | States | Repo

[

Link >

Note: The example data tables used in this session are all fictitious
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Format As Table

] This button is in the middle of the Home ribbon.

—ﬂj If you use data tables or PivotTables then | highly recommend that you start to use
Format the Format as Table feature in your files to define your tables.

- as Table ~ Unfortunately, most people think this feature is just about formatting, but it has

many other advantages.

Some of those advantages are listed below.

e Autofilter icons are automatically added to the column headings

e Field names become column headings as you scroll down the page

e Tables automatically extend as you add rows (records)

e Tables automatically extend as you add columns (fields)

e Formulas automatically copy down the column when created or modified

e Table format expands as you add columns or rows, this also include cell formats like
conditional formats

e Data Validations in cells in the table also extend as you add rows
e Table names (structured references) are automatically created and work like range names

e PivotTables based on formatted tables, when refreshed, automatically have their data
extended as rows or columns are added

e A Design ribbon tab is displayed when the table is selected. This allows you to name your
table and to add totals and control formatting.

e Additional right click options when you right click within the table
e Some keyboard shortcuts work differently within tables and make tasks easier
e You can't use a merged cell in a table (I consider that an advantage)

e You can use Slicers as filters with table in Excel 2013 and later versions
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Limitations of Tables
e You must be careful copying/dragging formulas that contain table column references. If you
use the Fill Handle to drag the formula across, the fields (columns) are treated like relative
references and move as you drag. In most cases this is not what you expect. This issue will
be demonstrated in the session.

e Can’t use Subtotal (on the Data ribbon tab) on a Formatted Table

e (Can’t share a workbook containing a Formatted Table. (Sharing is a little-used feature but
formatted table stops its use)

e (Can’t use a multi-cell array formula in a table
e Sheet protection can affect some table functionality

e |n some cases, you can’t copy a sheet containing a formatted table.

A B C D E F
1 Code Product Colour Weight(g) Cost Price
2 1234 Widget Blue 645 0.34 0.90
3 2345 Widget  Pink 327 0.28 0.70
4 3456 Widget Orange 651 0.70 1.80
5 4567 Gadget Blue 347 0.13 0.30
6 5678 Gadget Pink 346 0.86 2.20

PRACTICE:

1. Click anywhere within the above table in the Format_As_Table sheet. Click the Format as
Table icon on the Home ribbon.

2. Agallery of colour schemes is displayed — click a colour scheme.  [Format A= Table o ==
Where is the data for your table?
The keyboard shortcut Ctrl + T uses the default colour =3A31:5F58| B3
and also opens this dialog. ] My table has headers
[ QK ] | Cancel |

3. The Format As Table dialog is displayed confirming the data

range. Providing the data has no blank rows, or blank columns, Excel should automatically
select the correct range. Click OK.
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4. Excel will apply the format to the table A B C D
and add the filter icons to the column

headings. 1234 Widget  Blue

1

2

3 2345 Widget  Pink

4 3456 Widget Orange
5. Entering a new code in cell A7 will 5
6

automatically extend the table.

4567 Gadget Blue
5678 Gadget Pink

645
327
651
347
346

A4 Accounting

E

0.34
0.28
0.70
0.13
0.86

Code gProduct gColourg Weight (g)gCost gPrice g

0.90
0.70
1.80
0.30
2.20,

10.

11.

12.

13.

14.

15.
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Enter the word Margin in cell G1. This will extend the table to the right.

In cell G2 type = and use your mouse to select cell F2. Note what = G
happens to the formula. This is called a “structured reference”.

0.29|=[@Price

I

You can finish the formula by subtracting the Cost amount in cell

E2 — watch what happens when you press Enter to accept the formula.

Note the formula was copied down, even to the new row that only has a code in it. The
square brackets refer to structured references.

Modifying any formula in the column will update each other formula in the same column
when you press Enter.

The @ symbol instructs Excel to refer to the field on the same row as the formula it is used
in.

The table is given a default name eg Tablel, but you can change that to a more descriptive
name. When you have a cell selected within the table the Design ribbon tab is visible.

On the far left of the Design ribbon tab is the Table Name Table Name: Table Name:

box —you can click inside it and modify the name. | use the | Tablel thlParts

prefix tbl for my table names. E.g., tblParts, tblSales. {3 Resize Table ‘1 Resize Table
Properties Properties

The Table Name and structured references can also be used in normal formulas outside of
the table. In cell J1 enter
J K

=SUM( =SUM(thParts[Margin]‘

SUM(numberl, [n-u mber2], ..)

Then click cell G2 then hold the Ctrl key and press the Space Bar. This will select the whole
column and enter the structured reference in the formula. Press Enter to accept the formula
— this will also add the closing bracket to the formula. The advantage with using this type of
reference is that as the table expands the reference to the range expands with it.

When using the VLOOKUP function it is best practice to use a table name or range name as
the reference for the table within the function. In cell 12 enter 5678. In cell J2 enter the
following start of a formula I J K L

3.59
=VLOOKUP(I2, | 5678|=VLOOKUP(I2,thl I

VLOOKUP(lookup_value, table_array, col_index_num, [range_lockup])

[Eztoirars
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Start typing tbl and notice that the Table Name is displayed. Since it is highlighted in blue
you can press the Tab key to enter it. Using the tbl prefix ensures all the Tables are listed
together. Using the table name in a formula ensures the reference to the table doesn’t
change as you copy the formula within the spreadsheet. Usually, you must use a fixed
reference for the table. Using the table name avoids having to use the $ signs. The final
formula is shown below.

=VLOOKUP(I2,tblParts,2,0)

Copy Across Warning: In general, do not use the Fill Handle (cross at the bottom right corner of a
cell) to copy formulas containing structured column references across as the results are not what
you would expect. Use copy and paste instead.

VLOOKUP Warning: When working with columns in tables always add new column to the right.
Don’t insert columns within the table. Inserting columns within the table can break existing
VLOOKUPS, whereas adding columns to the right won’t break any existing VLOOKUP calculations

Other Shortcuts — within formatted tables

Tab key — the tab key works slightly differently in a formatted table. At the end of the row it will go
to the start of the next row. At the end of the table it will insert a blank row at the bottom of the
table.

Ctrl + + within a formatted table this will insert a row in the table, but not the rest of the sheet
Ctrl + - within a formatted table this will delete a row in the table, but not the rest of the sheet
Ctrl + a—on the first press this selects just the data, pressed again it includes the headings as well
Ctrl + Spacebar — selects the whole data column

Shift + Spacebar — selects the current data row

Using Range Names with Tables

One problem with structured references is that the formulas that use them become long. In general,
the longer the formula, the harder it is to read. To get around that limitation you can use range
names.

| won’t go into detail about range names, but | will give you a couple of examples where their use
can make things easier. Range names are a separate webinar topic in themselves.

© 2023 Neale Blackwood Page 6 of 16
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SUMIFS function

This function performs multi-criteria sum calculations and it can quickly become long when using
structured references. We can replace the structured references with range names to shorten the
formula and make them easier to create.

The table we will create is in the Sales Data sheet.

1. Click in the table and press Ctrl + t and then press Enter to create the formatted table.
Change the name of the table to tblSales.

2. We want to summarise the table. The report layout we want to use is in the Report sheet.

A B C D E F G
Customer Category NSW QLD SA VIC WA |Total
Government
Retail
Wholesale
Other
Total

(o2 TNV, RN - S  VE RN S I ]

3. If we use the structured references the formula for cell B2 will be
=SUMIFS(tblSales[Value],tblSales[Customer Category],SA2,tblSales[State],BS1)

This can be copied down and across. Remember don’t use the Fill Handle to copy across
when using structured references. It is OK to use the Fill Handle to copy down.

Because you have included the table name and column names the formula expands quickly.

4. We can create three range names that will shorten the formula plus you will be able to copy
the formula across with the Fill Handle.

5. Inthe Sales Data sheet select the Value column - data only. Click cell L2 and then press Ctrl
+ Spacebar. This selects just the data in the column and not the heading.

6. Press Ctrl + Alt + F3 this opens the New Name New Name 2 =
dialog. Name: salesValue
Scope: Waorkbook E
Change the name to SalesValue and click OK. ConmEnE

There is a function called VALUE, so best to avoid
that name.

E I

Refersto: | _tpisales[Value] [

’ oK ] | Cancel

7. Repeat that process for the Customer Category
column and call it Category and then the State column and call it State.

8. We can now create a new formula this time with range names. The new formula for cell B2
is

© 2023 Neale Blackwood Page 7 of 16
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=SUMIFS(SalesValue,Category,SA2,State,BS1)

You can use the Fill Handle to copy across and down.

Range names can be used throughout the file. Because these range names refer to the structured
references they automatically expand when new data is added. Range names can also be safely
copied across.

Data Validation

It is very common to use Data Validation to insert a drop-down list within a cell. It is also common to
want the item list to expand as new items are added to it.

In the past this required a range name and a complex formula. Now you use a range name and a
structured reference just like we did with the previous SUMIFS example.

A
In the Tables sheet we have a listing of states. 1 States
2 |WA
1. We want to create a drop-down list of states in cell E2. 3 [NSW
4 |VIC
2. Create a table for the States in A1:A5 called tblState. 5 |QLD
Note: we will use another name later in the session called tbIStates
3. Select the range A2:A5 and press Ctrl + Alt + F3 change New Name L2 e
the name to States and click OK. Name: | states|
Scope: Warkbaok E
4. Incell E2 press Alt a v v in sequence don’t hold them comment
down. This opens the Data Validation dialog.
Refersto: | _tpistate[states] [2]
aK ] | Cancel |
5. Selectc List from the Allow drop-down and s Vardaren B
then in the Source box type
Settings | Input Message | Error Alert
Validation criteria
=StateS Allowe:
List IZ| | Ignore blank
Data V| In-cell dropdown
CIle OK. between |z|
Source: -
= +
Try the drop down in cell E2 and then add e 2]
some other states to the bottom of the list
in CO|Umn A and see |f the drop dOWn Apply these changes to all other cells with the same settings
updates. Clear Al oK ] | Cancel
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Running Total in a Formatted Table

Formatted Tables allow you to create formulas that automatically copy A B c
. . 1 Date Amount Running_Total_1

down as the table expands. To create a running total in a column you 2 o101 105
. 3 | 2/01/2018 561
have a couple of options. Py
5 | 4/01/2018 172
The example on the right is in the Running Total sheet. We want to 6 5/01/2018 7
. i 7 | 6/01/2018 103
create a running total in column C. 8 | 7/01/2018 -84
9 | 8/01/2018 852
H 10 s/o1/2018 852
There are two solutions. 11 10/01/2018 o
12 11/01/2018 624
First create a formatted table and call it tbIData. 13|12/01/2018 683
14 13/01/2018 25
15 | 14/01/2018 -84
Structured references only 16 1s/01/2018 188
17 | 16/01/2018 -131
We can use those structured references to create the running total = i;ﬁgﬂjﬁis ‘Eg

e
L)

formula.

We can use the SUM function but there is trick to creating the formula. We need to use the colon :
symbol to separate the starting cell and the last cell for the SUM range. The problem with this
technique is that sometimes Excel won’t let you use the colon. It will let you use the comma, so that
is the workaround. Try to create it using the colon, if it doesn’t let you then use the comma and then
change the comma to a colon.

In cell C2 type
=SUM(

And click on cell B1 this enters the headers reference. Type a colon (or a comma if it won’t let you
type a colon) and click on cell B2 and add the closing bracket to the formula.

Then change the comma into a colon if necessary.
Press Enter.

The final formula is

=SUM(tbIData[[#Headers],[Amount]]:[@Amount])

This formula is identical in all the formula cells in column C.

This formula works because the SUM function treats text entries as zero — e.g. the heading in cell B1
is treated a zero.

Structured reference and a cell reference

The second technique combines a structured reference with a relative cell reference.
We will add another column to demonstrate this technique. In cell D2 type

=SUM(

Then click on cell B2 and type a comma then type D1 and press Enter.

The final formula for cell D2 is

© 2023 Neale Blackwood Page 9 of 16
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=SUM([@Amount],D1)

This formula works because the SUM function treats text entries (cell D1) as zero and doesn’t display
a #VALUE! error.

If you had used
=[@Amount]+D1

It would display have displayed a #VALUE! error.
Referring to other rows

In general, you don’t refer to another row in a table, but in this case the running total formula works
even when the table is sorted.

Automatically adding text in a table

Let’s say you want the word Actuals in a new column in all the rows of the Sales table. If you type it
as an input and copy it down and add new rows, then the new rows will be blank in that new
column.

What you can do is instead is to create a formula like

="Actuals"

Because this is a formula it will automatically be copied down when you add new rows.

WARNING: Pasting in new rows

When pasting at the bottom of an existing table make sure the data has the same number of
columns or less. Obviously, the columns need to line up.

If you paste more columns beneath an existing formatted table, the table won’t expand to include
those new rows.

Try copying using the data on the Paste sheet to paste on the bottom of the Sales table. The data has
three extra columns.

© 2023 Neale Blackwood Page 10 of 16
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Using Formatted Tables with PivotTables

Let’s return to the Sales Data sheet. Click inside the table and click the
Design ribbon tab.

The Summarize with PivotTable button allows you to create a PivotTable
to summarise the table.

You can also use Alt n v pressed in sequence.

PivotTables have a drag and drop interface that allow you to create
reports.

A4 Accounting

Summarize with PivotTable ?
E‘H Remove Duplicates k
Insert

%Con\rer‘tto Range Slicer

Tools
O Gridiines | [ [ (& &2

Summarize with PivotTable

Summarize the data in this table
using a PivotTable.

[ PivotTables make it easy to arrange I
and summarize complicated data
and drill down on details.

They take a copy of the data and the copy is
what you are working with.

Create PivotTable

. . @ Select a tabl
Hence, if the data is changed you must > aelecta table arrange

Tahle/R 3
Refresh the PivotTable to update the figures. sevie/ange: | EAER

) Use an external data source

The advantage with using a formatted table Choose Connection..

Choase the data that you want to analyze

as the data source for a PivotTable is that connection name
when you Refresh the PivotTable any

additional rows or deletions are @ New Worksheet
automatically updated in the PivotTable. ) Existing Worksheet
Location:

We can create the same report we created

Use this workbook's Data Maodel

Choose where you want the PivotTable report to be placed

Choose whether you want to analyze multiple tables

B

earlier without any formulas — see image [C] Add this data to the Data Model
below. QK l I Cancel J
A B C D E [F G H 1 1
1
2
3 |Sum of Value _ICqumn Labels |
4 |Row Labels ~ ACT NSW NT aLp SA TAS VIC WA Grand Total
5 |Government 10294.8 1070592.85 659.6 676774.75 1122990.95 3178.05 473862.7 749587.6 4107941.3
& |Other 1987. 3417446 185819.25 1533689.95
7 |Retail 1576, PivotTable Fields v X 35025225 9974651 6227209.45
& Wholesale 1683 170625.85 6459884.6 5467294.95
9 |Grand Total FEp| GRS s 7| 35364854 2582756.55 17336135.65
10 < -
& Search 2
12 [ Date -
13 [ Invoice
14 [ Customer
15 [F] Cuctamar Cateanm e
16
17 Drag fields between areas below:
13 Filters Columns
= Sales_State -
20
21
22 Rows Values
23 Customer Category M Sum of Value M
24
25
= Defer Layout Update
27

© 2023 Neale Blackwood
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Filtering Formatted Tables with Slicers

Slicers were added in Excel 2010. They are a filtering interface for [ D
PivotTables. Xl B
Insert  Export Refresh
Slicer, - -
In Excel 2013 you can add a Slicer to a formatted table. In the Design External Table Data
ribbon tab use the Insert Slicer Icon. e & = O
Insert Slicer
Retum to the Sa|eS Data Sheet and add a Slicer to the table. Use a slicer to filter data visually.
. . . = Slicers make it faster and easier to
The interface is quick and easy to use. § filter Tables, PivotTables,
PivotCharts, and cube functions. |
. . b L HeTan . & ]
Hold the Ctrl key down to select multiple items. [ S— ror— - r——
. . i i Government Barry Ellis aLo Widget W
There is an icon at the top of the slicer that also allows multi-  Government Ba( = S Re
. Government gar Customer Category v= G Re
selection. = per| [Government w
Government Bar| Re
Government Bar| Other Bl
Government Barl Retail Bl
Government Bar| Wholesale W
Removing a Tab'e Government Bar| Bl
Government Lin Bl
Government Bar Bli
If you need to remove the formatted table features — eg you Government Bar Re
. . o Government Bar W
might need to insert subtotals, then you can use an icon on Government B =
the Design ribbon table that reverts the Table back to a Government BA0— —e—()1 Bl
Government Barry Ellis SA Widget Re

normal range. -

Note: it doesn’t remove the formats that have already been applied. It removes all the formatted
table features. Any formulas are converted into normal Excel cell references.

o To remove the formatted table features you can use the Convert
g=1 Convert to Range to Range icon on the Design ribbon tab. You can also right click the
table and select Table and see the option.

This is also available on the right &) Quick Analysis
click for a formatted table. Sort 3
Filter *
Table > HF Totals Row
'll;j Mew Comment Conwert to Ralﬁe
13 New Mote Alternative Text...
o - n
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Relationships

This applies to Excel 2013 and later versions. = =
B5 ol
In older versions of Excel, a VLOOKUP function would have L= L=

been used to achieve what we will do with a new feature RS | Group Ungioup

added in Excel 2013, called Relationships (Data menu). lk T
The Problem I Relationships I
We have a Sales Data table that contains a State field and Create or edit relationships between

tables to show related data from

we have a State table that has a listing of states and their different tables on the same report,

respective regions — see image on the following page.
e Tell me more

L R
A B C D E F G
1 Date Invoice  Customer Customer Category Sales Rep Sales State Product Col
2 | 1/o01/2018 12689 Northern Products Ltd Wholesale Kylie Ford aLp Widget Wh
3 | 1/01/2018 12690 XYZ Lid Retail Linda Garland WVIC Gadget Bla
4 | 1/01/2018 12691 Peabodies Retail Shirley Clark QLD Widget Bla
5 | 101 2018 12692 X¥7Z Lid Retail Linda Garland NSW Gadget Blu
& | 1/01/2018 12693 Consolidated Distributors Ltd Wholesale Barry Ellis SA Widget Rec
7 | 1/01/2018 12695 Peabodies Retail Shirley Clark  ACT Widget Bla
We want to use a Pivot Table to report on sales by region. A B
Pivots Tables can only use ONE table as its source — that is until 1 |State Region
Relationships were added that allow you to create a relationship 2 Qb North
3 INT North
between tables.
4 VIC South
Since we have a state field in the Sales data we can “relate” that to the 5 |TAS South
state field in the State table and find the region. That region can then be 6 |NSW East
used in the Pivot Table for reporting. 7 ACT East
8 WA West
This is similar to relational data base reporting where tables have a 9 SA West
unique field that can allow you to link tables together based on a 1n

common field between two tables.
In Excel fields are columns and rows are records.

When using Relationships one of the tables must have unique entries for the shared field —in our
case that is the State table — the two-column table above. This is commonly called the lookup table.

Format as Table

To use Relationships both tables must be defined using the Format as Table. Using descriptive table
names makes creating the Relationship easier.

© 2023 Neale Blackwood Page 13 of 16
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The Sales data table is already name tblSales. Use Format as Table on the two-
column table and name it tblStates. II:ID

The Set Up Relationships

Click the Data ribbon, click the Relationships button and click New.
Create Relationship @

Pick the tables and columns you want to use for this relationship

Table: Column [Foreign}:
|~ | B2
Related Table: Related Column [Primary):

Creating relationships between tables is necessary to show related data from different tables on the same report.

or ] [t )

Select tblSales and Sales_State in the top two drops downs and tblStates and State in the bottom
two drop downs — see image on the following page.

Create Relationship @
Pick the tables and columns you want to use for this relationship
Table: Column {Foreign):
tblSales [=] |sales_state [=]
Related Table: Related Column [Primary):
tbiStates =] | - |

Creating relationships between tables is necessary to show related data from different tables on the same report.

[ oK ][ Cancel ]

Click OK and then click Close.

Manage Relationships
Status Table Felated Lookup Table
Active tbl5ales [Sales_State) thlStates (State)

To create the Pivot Table report requires selection of a different options than usual.

© 2023 Neale Blackwood Page 14 of 16



Format as Table Features by Neale Blackwood

Click the Insert ribbon and click Pivot Table.

Select the “Use this workbook’s Data
Model” option and click OK.

A4 Accounting

Create PivotTable

2 sl

Choose the data that you want to analyze
(") Select a table or range

Table/Range:

(2]

tbl5ales

(") Use an external data source

Choose Connection,..

nnection name:
@) iUse this workbook's Data Model:

wotTable report to be placed

@ Mew Worksheet
() Existing Worksheet

Location:

Choose whether you want to analyze multiple tables

Add this data to the Data Model

Below is an example of a PivotTable report using multiple tables.

Tables Illustrations arl
The Customer T N
H - M Gridlines | [@ [& [& &2 O f rivotiable rields ~ 1
Category and .
Value COlumns A3 - L sum of Value Choose fields to add to report: -
T i A B © D E F
(fields) are in the ; — 5
tblSales table. 2 o .
3 |Sum of Value _ICqumn Labels |~ Value
H . 4 |Row Labels - East North South West Grand Total [] Cost
The Reglon fleld 5 |Government 1080887.65 677434.35 477040.75 1872578.55 4107941.3 [ Margin
is in the tbiStates 6 |Other 415987.65 408026.25 3480371 361638.95 1533689.95
7 |Retail 1408343.7 1130903.75 1269242.535 2418719.45 6227209.45 4 [ thiStates
ta ble 8 |Wholesale 1242481.9 11343404 1437585.05 1602887.6 5467294.95 L state
9 |Grand Total 4147700.9 3350704.75 3581905.45 6255824.55 17336135.65 Region .
AS bOth ta bleS ig Drag fields between areas below:
are related you 12 Filters RS
. 13 -
can use fields 1 Region
from each to -
create the report. 7 R 3 e
12 Customer Ca... ¥ Sum of Value -
Creating =
relationships 2
between tables 23 Defer Layout Update

24

expands
reporting options.

Date Tables

Another common use of Relationships is to create a date table to allow reporting by financial year in
a PivotTable. The date table needs to include every day of the period you are working with.

© 2023 Neale Blackwood
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Dynamic Arrays

Dynamic arrays are new way of calculating formulas in Excel. You need Excel 2021 or the
subscription version to use them. They work seamlessly with formatted tables.

This will be a brief introduction to the topic. It provides a glimpse into the power of using them.

Let’s return to our Sales Data sheet.

In cell P1 enter the following formula.

=UNIQUE(tbISales[Customer])

This is a new function that was introduced with dynamic arrays. This lists all the unique entries in the
Customer column of the table.

Things to note:

1.

The formula spills down as far as required to list all the customers. Spilling is a new formula
term. The range created is called the spill range. A formula can spill down or to the right or
both down and to the right.

The formula is only in cell P1. The cells P1 - % | =UNIQUE(tblISales[Customer])
below do not contain a formula. They are

empty and the formula is greyed out in the

formula bar in the cell. See image on right.

If a cell in the spill range has an entry a #SPILL! error u P
is displayed — see image on right. #SPILLI
Note IFERROR does not handle the #SPILL! error. | 123

In cell Q1 enter the following formula.

=SUMIFS(tbISales[Margin],tbISales[Customer],P1#)

The # on the end of the P1 reference refers to the spill range. This creates its own spill range
that will match the first spill range. When referring to a spill range always refer to the top,
left cell of the spill range —the cell that has the formula in it.

In cell R1 enter the following formula.

=SUM(Q1#)

This adds up the spill range.

Dynamic arrays are a new powerful feature that work well with formatted tables.
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